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Software Required 
 

VAC Virtual Audio Cable http://software.muzychenko.net/eng/vac.htm 

Virtual Serial Port Emulator http://www.eterlogic.com/Products.VSPE.html 
CW Skimmer (if Skimmer required) http://www.dxatlas.com/Download.asp 

Omnirig (if using CW Skimmer) http://www.dxatlas.com/Download.asp 

 
Optional Software 

Ham Radio Deluxe   V5 (free) 

 

 
Ham  http://ham-radio-deluxe.com/ (paid) V6 Deluxe Radio 

 http://www.iw5edi.com/software/ham-radio-deluxe-5-download-links
 

RCKRtty ttps://drive.google.com/file/d/0B_zVSBz8tNaN0RZaWpQOHQtUFE/view?pref=2&pli=1 h 
Swisslog http://www.icap.ch/english/Frame_EN.htm 
N1MM+ http://n1mm.hamdocs.com/tiki-index.php 
MultiPSK http://f6cte.free.fr/index_anglais.htm   
WSJT-X/JTDX http://physics.princeton.edu/pulsar/k1jt/wsjtx.html 
   http://www.qrz.lt/ly3bg/JTDX/jtdx.html 

FLDigi  http://www.w1hkj.com/ 

K9DUR DVK http://k9dur.rnaconsultingservices.com/voice_keyer.html 

5MContest  http://5mcontest.qrz.ru/ 

Software Defined Conne (enhancedctors 

  

external a  
 etc) TCI, or COM via devices external for CAT Skimmers,

 localnd

SDC https://www.dropbox.com/s/z2t2vr7xs6fn1z3/setupSDC863.zip?dl=

---------------------------------------------------------- 

0
0=dl?ipzsetup._9_SDC6q5/p7nji20fdkkf/s/www.dropbox.com://SDC https    - 7v9.1 
   - v8.63 

 

HOW TO SET UP VAC AND CAT 
 
The minimum number of virtual audio cables and com ports required to use 
your MB1 is zero! You can attach an antenna and microphone/key, switch 
on, run the ESDR2 software and be on the air. If you want to use digital 
modes, a minimum of 2 VACs are required. If you want CAT to a logbook, a 
minimum of 2 com ports paired together are needed. 
 
This document covers the demands of power users who want to use 

 

 

multiple

and  antenna), dynamic or auto-ATU

 (amplifier, device external controlled CAT a software, party  3rd 

want to experience digital modes and 
computer logging. For those not needing such complexity, simply follow the 
principles below and configure your MB1 accordingly. If, on the other hand, 
you want one or more of CW Skimmer, control of an external device, contest 
software & facilities, etc then it is all described here. 
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Whilst I have written this document from the perspective of a MB1 user, 
since that is the radio I have, the common factor among all Expert 
Electronics’ products is the ESDR2 software and hence what follows is 
equally relevant to the family of SunSDR radios. 
 
Ensure you have the latest ExpertSDR2 software and firmware installed for 
your MB1. For all of the following software packages, ensure that you set in 
the Properties of every exe file, ‘Run as Administrator’.  Do this also for the 
ExpertSDR2 software. The following setup procedures are for RX1 only, 
except where noted. Duplicate for RX2 but ensure you create new VAC and 
com port pairs for that receiver. 
 
 

INSTALLATION AND SET UP 

 
Install Virtual Audio Cable.  
 
To allow the connection between ExpertSDR2 and various software, it is 
necessary to create up to 9 virtual audio connections through the VAC 
software.   
 
Run VAC (with administrator priviliges). You will see the configuration 
screen. 
 

 
 
Top left, Driver parameters, increase the number of cables to 9 and press 
Set. 
 
For cables 1 to 4 inclusive, the Cable parameters are 8000…192000  
For cables 5 and 6, the Cable parameters are 22050…192000 
For cables 7 to 9 inclusive, the Cable parameters are 22050…96000 
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The Stream Buffer parameter should be changed to 10ms for cables 1,2, 7,8 
and 9. This improves latency (delay on the audio path). 
 
After completing the setup above, click Set (near Stream buffer (ms)) to 
save, Restart Audio Engine and Exit. VACs are permanently created and 
there is no need to run the software again. 
 
VAC 1 to 4 are used for Numeric communications TX, RX  
VAC 5 and 6 are used for I/Q Skimmer  
VAC 7 is used for connection «Audio I/O» Skimmer   
VAC 8 is used for output line ESDR2  
VAC 9 is used for monitoring SSB through the MB1 sound card for a Digital 
Voice Keyer and recorded audio playback 
 
Should the software report an error when trying to save the configuration, 
stop the Windows Audio Service. It can be restarted after VAC has been 
setup. 
 
 
Setting VAC in ExpertSDR2 
 

 
In Options>Device>VAC set the RX to VC1 and TX to VC2. 
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Install Virtual Serial Port Emulator 
 
Note: There is an alternative virtual port emulator, Com-0-Com. Please refer 
to the section below on ‘Software Defined Connectors’ for details. 
 
The 64-bit version launches with a pop-up box asking for paid registration. 
This is a nominal cost but the software will run perfectly well if the box is 
simply dismissed. 
 
For CAT to software such as a logger, CW Skimmer and so on, the COM port 
pairs 5>6 for CAT and 9>10 for PTT are all that are required. 
From the top menu, go to Device and Create.  
 
Select Connector and set it to COM 5.  
Repeat Device and Create, this time choose Splitter and set it to Virtual Port 
6 and Data Source Serial Port 5. 
 
Use Device, Create, Pair to make the COM 9 to COM 10 pair. 
 

 
 
Note: you are obviously free to use different port numbers so long as you change the 
ports in the following sections. Be aware though that COM 1 is the hardware port on 
the rear panel of the MB1. COM 2 is reserved. I am using additional com ports: COM 
3 for USB control of an external PA and COM 4 for USB Winkeyer device. Hence my 
configuration starts at COM 5.  
 
If you also need CAT at the MB1 hardware com port, for either external 
amplifier CAT, auto-ATU, or for a CAT link to another computer, you redirect 
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COM 6 so that it transfers data from COM 5 to COM 1. In VSPE, go to Device, 
Create, Serial Redirector and select COM1 on the left and COM 6 on the 
right. 
 
When finished with the setup, go to File and Save As: save to the desktop 
or other suitable location. The configuration file must be run before 
ExpertSDR2, therefore ensure ESDR2 does not load at boot up. 
 
It is convenient to have VSPE automatically start when you turn on the MB1 
and Windows boots. For example, my VSPE configuration file is 
‘MB1_Virtual_Ports. vspe’ and is saved to the Documents folder. To run it 
automatically, create a bat file by opening Notepad in Windows Accessories 
and typing the following line: 
START "" "C:\users\MB1\documents\com2_com7_com1.vspe" (note the double 
quotes “” after START). 
Save this file in Documents by going to File>Save As, change the ‘Save as 
type’ to ‘All Files’ and for file name put ‘VSPE.bat’ – then click Save. 
Now open Task Scheduler in Windows. Create a Task to run the bat file. Give 
the Task a name (example: VSPE Run), the Trigger is ‘At log on of any user’, 
the Action is Start a program – C:\Users\MB1\Documents\VSPE.bat – save 
this. 
 
If you want ESDR2 to also start automatically, create another Task for it in 
Task Scheduler. This time add in a start delay of 30 seconds. This will ensure 
that VSPE has started and created all its virtual com ports before ESDR2 
accesses it. 
 
 
Setting CAT in ExpertSDR2 
 
Open Options and select the CAT tab. The settings for CAT and PTT (used by 
some of the software below) are shown in the screenshot below. Do not set 
PTT line and Key line unless you find you need them otherwise some 
software will assert PTT in the MB1 when you don’t want it to.  
 
CAT Protocol ECATv1 is identical to Kenwood TS-480. The ports used in the 
ExpertSDR2 software are the source side of com port pairs. Your application 
software will be to be set to COM 6 for CAT and COM 10 for PTT where 
required, as we will see later. 
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A VSPE Case Study 
 
A common question asked of me is how to configure VSPE for port sharing 
between, for example, a logbook program and a digital mode program. In 
this case study the MB1 owner had Logger32 and FLDigi, neither of which 
are compatible with Omnirig and therefore he needed an alternative way of 
directing the ESDR2 CAT to both applications. 
 
In ESDR2, the CAT port had been defined as COM 2. In other respects, the 
CAT parameters are as per the above image. To get the desired result, this 
is what is required in VSPE: 
 

1 Create a Connector, COM 2 with ‘Emulate baud rate’ checked. 
2 As above, create Connectors COM 3 and COM 4 
3 Create a Splitter COM2 => COM 5 
4 Create a Serial Redirector COM 5  COM 3 
5 Create a Serial Redirector COM5  COM 4 

 
VSPE will therefore be configured thus: 
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Don’t forget to save this configuration and have it load before ESDR2. 
 
All that is required now is to configure Logger32 to use COM 3 and FLDigi 
to use COM 4 (or vice versa). 
 

------------------------------------------- 
 

EXTERNAL AMPLIFIER INTERFACING 
(SPECIFICALLY, THE SPE EXPERT 1.3K-FA) 

 
Note

 56. page on v9 SDC and protocol TCI with but comport virtual without  and62 page
 on v8 SDC and COM-0-COM via devices: external to interfacing CAT of methods alternative 

 
By virtue of having redirected COM 6 to COM 1, as above, the MB1 
hardware port on the rear panel now carries CAT data. It can be used for 
connecting to another computer via a null modem cable or to the CAT port 
of an external amplifier or other device that needs to follow the frequency 
of the radio. 
 
It is beyond the scope of this document to give instructions for every 
amplifier, automatic ATU, dynamic antenna and so on. So, I give only the 
details for the SPE series of amplifiers as I have the 1.3k-fa. From this you 
will be able to ascertain what is required for your own equipment. 
 
For a CAT controlled amplifier, a fully wired null modem cable is not 
required. The pin diagram for the SPE Expert 1.3k to the MB1 is shown 
below. 
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The other needed connections are PTT and ALC. Note that as at April 2017, 
ExpertSDR2 1.2.0 Alpha 5, ALC is not yet implemented in the MB1. It is 
therefore necessary to always turn Drive to a very low level to avoid 
excessive input to the amplifier. For PA control, turn ON the external PA 
control in the MB1 software and set up PA in Options. Avoid hot-switching 
by setting a PA delay of at least 10ms. Refer to your PA’s user manual. The 
headings X8, 1, 2, 3, 4 refer to the PTT connectors on the MB1 rear panel. 
 

 

 
------------------------------------------ 
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SOFTWARE FOR LOGGING AND DIGITAL 
 

With VAC and Virtual Serial Port Emulator installed and configured as 
above, CAT and, where applicable, PTT settings are described as follows: 
 

 
 
OMNIRIG 
 
Omnirig is required if CW Skimmer is to follow the radio. Open Omnirig and 
configure it: 
 

 
 
The MB1 CAT emulates Kenwood TS-480 
and the application end of our com port 
pair for CAT, as defined in VSPE, is COM 6. 
We set the Baud Rate at 19200 in 
ExpertSDR2. Keep RTS and DTR set at Low 
to prevent unwanted assertion of the PTT 
in the MB1. 
 
As we shall see later, Omnirig will allow 
more than one application to attach to it 
simultaneously. It can also be configured 
for a 2nd radio so you might, for example, 
have an Icom IC-7300 connected to the 
MB1 computer via USB for 4 metres. VSPE 
could then be used to create a new com 
port pair for the purpose of linking a 
logbook to the IC-7300 radio via Omnirig. 
 
The addition of that new com port pair 
would also allow the CAT of the MB1 
second receiver RX2 to be configured in 

Omnirig, using the RIG 2 tab.  
 
 
 
 
Once configured, close Omnirig. The settings will be saved. Any application 
that requires it, like CW Skimmer, MixW, DX Monitor, LogHX, Win-Test, 
Logic 9, JT65-HF, PZT-log, Log4OM, Live MUF v7 and Swisslog (described 
below) will run Omnirig silently in the background. 
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CW SKIMMER 
 
In Skimmer Settings, configure the Radio, Audio and Telnet tabs as follows. 
Note that in Audio settings, only VC5 in Signal I/O Device is required. Audio 
I/O Device is if you want audio to your computer sound card. If you do, set 
it to VAC9. 

 

 
 

 
 
 
This assumes that the 
sample rate selected in 
the ExpertSDR2 
software is 78125. 
Skimmer will skim the 
chosen bandwidth with 
its centre on the 
frequency tuned. 
 
 
 

 
 
Now set up Skimmer in the CW Skimmer tab of ExpertSDR2. Choose the 
same telnet port as you set up in Skimmer. See below. 
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If you want to see Skimmer spots on the 
MB1 spectrum display, go to 
Options>Display and Spectrum tab, and 
check ‘Show Spots’. Currently there is no 
filtering available but this should be 
addressed in a future ExpertSDR2 release. 
 
There is also a bug whereby if ‘Tune 
frequency from CW Skimmer’ is checked, 
the MB1 frequency wanders and is not 
stable.  
 
Using the Features Tab in Options, you can 
set the path to CW Skimmer to have it 
automatically launch when starting 
ExpertSDR2. 
 
If your logging software allows for user-
defined Cluster access via telnet, you can 
set up a telnet client window to output 
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spots to your program. A configuration example is shown later in the 
coverage of N1MM+. The output will be similar to the picture above. The DX 
Messages window (from Swisslog) is filtered to show only non-EU DX. 
Hence it displays what my MB1 heard outside of Europe, as denoted by 
EI4KF-#, as well as normal DX Cluster spots. The raw data of everything 
being heard by the Skimmer is seen in the telnet window. RTTY Skimmers 
are also available and are set up in a similar fashion. 
 
The SKM button allows you to manually connect and disconnect CW 
Skimmer. This is useful if you do not want to launch Skimmer automatically. 
 

 
 
 

Connecting two CW Skimmers to ExpertSDR2 Software 
 
Two CW Skimmers can be connected to the two receivers in ExpertSDR2. 
This is a useful feature when you need to skim two bands simultaneously, 
for example in an SO2V contest setup. 
To be able to run two parallel copies of CW Skimmer you need to create a 
separate configuration for your second skimmer. Create a shortcut on the 
desktop with a descriptive name, for example “Skimmer_RX2”.  
 
Open properties (right click on the icon) and insert the following argument 
after the path and file name in the Target field: 

ini=”C:\Users\Public\SkimmerRX2.ini” 
 
The complete line should look something like this, make sure there is a 
space before the ini= statement: 

"C:\Program Files (x86)\Afreet\CwSkimmer\CwSkimmer.exe" 
ini=”C:\Users\Public\SkimmerRX2.ini”  
 
You can place the .ini file in the same directory as the first skimmer's data 
directory as long as it has its own unique file name. 
 
Run this shortcut to open this copy of CW Skimmer. In Settings, the Radio 
Tab is the same as before. In the Audio Tab, select Virtual Cable 6 instead 
of VC5. Then on the Telnet Tab, the port should be 7301 instead of 7300. 
 
Go to ExpertSDR2 Options and the CW Skimmer Tab. This time select 
Receiver 2 and set the port to 7301 and Output to Virtual Cable 6. Callsign 
and any optional Password are the same as before.  
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For CAT, create an additional com port pair in VSPE, for example COM 7 and 
COM 8. On the CAT tab in ESDR2, Receiver 2 tab, the port name will be COM 
7. 
Use the Rig2 tab in Omnirig to set up an identical radio to Rig1 but this time 
the port will be COM8. 
 
If you want this 2nd Skimmer to start automatically, use the Feature tab 
again and enter another instance of the path as before. In the ‘arguments’ 
box, enter the ini path. In the above example it was 

ini=”C:\Users\Public\SkimmerRX2.ini” 
 
 
 
HAM RADIO DELUXE 
 
HRD and most logging software are very simple to configure. Just 
remember that as with VAC, com ports are in pairs. We set COM 5 at the 
MB1 end and so we must set COM 6 at our application software. For HRD it 
is therefore like this: 
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Again, remember that the CAT protocol you see in ExpertSDR2, ECATv1, is 
the same as Kenwood TS-480. If you find that HRD has difficulty 
connecting, try increasing the Speed (Baud Rate) to 115200 with only RTS 
checked. The mis-match in Baud Rate doesn’t really matter because the 
VSPE software emulates the speed anyway. 
 

 
HRD DM-780 Digital 
 
It is extremely simple to set up DM-780. In Program Options>Soundcard, 
select the VAC pair VAC Line 1 and VAC Line 2. This will be valid for all the 
AFSK digital modes available in HRD. PTT is done via CAT, therefore you 
need only the link between DM-780 and the HRD rig interface. HRD 
documentation explains this. 
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The MB1 mode for digital can be either DIGU or DIGL (USB or LSB). In 
Europe, the convention is to use DIGU (USB) for RTTY. In some software, 
HRD included, the mode is reported as FSK-R. Nevertheless, DIGU is correct 
for normal decoding in DM-780.  
 
 

 
RCKRtty 
 
This software, though no longer updated by DL4RCK, is very easy to use for 
everyday and contest operations. All the popular RTTY and PSK contests 
have pre-defined F keys and exchange macros. Callsign capture and 
automatic logging work well in it. It uses MMTTY for RTTY and PSKCore for 
PSK.  
 
The main program setup is shown below, together with the setup of MMTTY 
which is also used by N1MM+ for digital operations.  
 
In the RCKRtty main window, select Setup and Transceiver Setup and input 
the required parameters as below. 
 

 
 
 
That completes the interfacing for CAT for the MB1.  
 
Now MMTTY needs configuring. In the RCKRtty main window, select Setup 
and Program Setup. Ensure that checkmarks are against ‘Start MMTTY with 
menu bar’ and ‘Start MMTTY with ControlPanel’. If these check marks were 
already present, click OK to return to the main screen. If not present, check 
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these functions, click OK but the program has to be closed and reopened for 
the changes to be in effect.  
 
On reopening RCKRtty, you will see the MMTTY menu bar. Click 
Option>Setup and go to the SoundCard tab. Select Line 1 VAC for Reception 
and Line 2 VAC for Transmission. 
 
Now go to the TX tab. Set the PTT Port to COM 10. 
 
That completes the RCKRtty and MMTTY configuration. See pictures below. 
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SWISSLOG 
 
One of the virtues of using Virtual Serial Port Emulator is that a single CAT 
port can be shared among several applications. So you can run CW Skimmer 
which interfaces with the MB1 via Omnirig on COM port 6 and Ham Radio 
Deluxe on COM port 6 simultaneously. Since Omnirig is likely to be running 
in the background on the MB1 computer anyway, it still makes sense to use 
it if possible, rather than make the application share the COM port. 
Therefore, where software can use Omnirig, I prefer to take advantage of 
that method. Omnirig is multi-threading and designed to have several 
applications attached to it at the same time. 
 
Swisslog is one such application that can use Omnirig. Hence it is simple to 
set up the CAT interfacing. 
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MULTIPSK 
 
The screenshot shows the configuration screen. PTT is required in this 
software so click serial port in the top menu and select COM port 10. Sound 
Card (Input) and Sound Card (Output) are the usual Line 1 (VAC) and Line 
2 (VAC) respectively. 
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WSJT-X/JTDX 
 

 
 
For weak signal VHF and UHF digital modes such as JT65, JT9 etc WSJT-X is 
nearly everybody’s software of choice.  
 
A significantly improved version, called JTDX, is used for JT65 on the HF 
bands. Its advantages are that it decodes every station that responds to 
you on your DF. This is unlike, for example, WSJT-X and JT65-HF that 
usually fail to decode at all if several stations answer at once. 
 
WSJT-X and JTDX can use Omnirig for CAT and PTT. Ham Radio Deluxe is 
another option. Both provide the CAT and PTT links to the MB1. I find that 
these methods sometimes have problems with PTT. The most reliable 
configuration is direct as shown above. 

 
 
FLDIGI 
 
Fldigi is in many ways superior to MultiPSK and RCKRtty. It caters for many 
digital modes and it automates QSOs and logging when in run mode. For 
contests, whilst it does not have pre-defined F keys and macros, it does 
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provide a contest set up section for you to configure the relevant exchange. 
It doesn’t provide the complete contest facilities and scoring of N1MM+. 
 
There is some mis-information about how to configure this software for the 
MB1. The audio set up is straightforward using the normal VAC 1 and VAC2. 
 

 
 
For CAT and PTT, the RigCAT method is better method for CAT but keep CAT 
command for PTT unchecked: 
 

 
 

Then for PTT use the Hardware PTT Tab to setup a direct link to ESDR2. 
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N1MM+ 
 
N1MM+ is a popular choice for contesting as it automates much of the QSO 
in SSB, CW and digital modes. It also automatically logs and scores for 
virtually every event in the contest calendar. It takes some practice to 
become totally familiar with it and the set up can feel daunting. But what 
follows should get you started. The N1MM website has a comprehensive 
instruction manual. 
 
When N1MM+ is started, select the Config tab and select Configure Ports, 
Mode Control, Audio, Other. 
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Single operator, one radio configuration is achieved by selecting COM 6 for 
the port. The radio is the TS-480. Check CW/Other and then click on Set and 
apply the port parameters above. Note the check in PTT for SSB, necessary 
for sending SSB macros. Click OK to save. 
 
If you want to use the MB1 2nd receiver, set up the com port pair in VSPE as 
COM 7 and COM 8 as was done for the 2nd Skimmer. On another line under 
Port (see above), select COM 8 and TS-480. Check CW/Other and click on 
Set. In the COM 8 parameters box, the settings are as above except that the 
Radio Nr is 2. Press OK to save. 
 
Skimmer with N1MM+ 
 
From the main N1MM+ window, select Tools and Telnet Window Tools. Go 
to the Clusters tab and Edit List. In the box that appears, scroll to the 
bottom and enter the details of your Skimmer(s). 
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The Skimmer address and port number are separated by a colon (:) and if 
you had two Skimmers the Cluster name for it would be SKIMMER2 and the 
URL would be 127.0.0.1:7301 (local ip address of the MB1 computer and 
port number). 
 
Now press OK to save and return to the main N1MM+ window. Go to the 
top menu and select Window and Telnet. This will open another box. Go to 
the Clusters tab and make the Selected Cluster = SKIMMER. 
 

 
 
 
The telnet window will start receiving data flow. 
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Recording and sending SSB audio with N1MM+ 
 
For contest operations, it can be useful record QSOs on the fly and replay 
them. Also, for transmitting, SSB macros (Digital Voice Keyer) can save 
straining your voice.  
 
 
 
N1MM+ configuration for recording and transmitting SSB macros 

 
Go to N1MM+ 
Config and look for 
‘Logger + Audio 
Setup’. In the box 
that opens (see 
below), configure 
the VAC cables for 
recording and 
transmitting. 
 
See that finally our 
9th VAC is being 
used. This 

monitors 
messages being sent to the MB1 from the Digital Voice Keyer. If you have 
headphones connected to the MB1 and the Speaker OFF (use the MB1 
Utility), your DVK macro will be monitored via those headphones. This helps 
identify any over-driving like the normal Monitor circuit. 
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ExpertSDR2 configuration 
 

 
 
 
The MB1 end of the VAC9 cable is VAC8. Therefore, we need to set this in 
ExpertSDR2. Go to the Sound Card tab in Options and configure as above. 
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Recording 
 
Download QSOrder as a zip file from the QSOrder project area at 
https://sourceforge.net/projects/qsorder/  
The files should be extracted to ..Documents\N1MM 
Logger+\QsoRecording in order to play correctly from the N1MM+ log 
window. 
If you prefer to save uncompressed WAV files instead of MP3s then simply 
delete lame.exe. ('Lame' is a very fast, free MP3 encoder). 
Create a folder in which you will store the non-contest recording files. In 
the QsoRecording directory, make a folder called AUDIO_YYYY (where 
YYYY is the year). 
 
QSOrder uses N1MM Logger's UDP broadcasts. The broadcasts trigger a 
dump of the audio buffer to a file after a specified delay time (default is 20 
secs). The delay helps with capturing a tail-end after a QSO was entered 
into the log. 
 
Find the [ExternalBroadcast] section in your N1MM Logger.ini and include 
the lines below. This enables local QSO info UDP broadcast. Restart N1MM 
after making changes. 
 
[ExternalBroadcast] 
BroadcastContactAddr=127.0.0.1:12060 
IsBroadcastContact=True 
 
To use QSOrder for a particular contest, start the QSOrder program and run 
it at the same time as N1MM Logger. Each time a QSO is logged in the 
Logger, a UDP broadcast will trigger QSOrder to save a recording of that 
QSO. Recordings are saved in a sub-folder named by contest-name and year 
(created automatically), and each QSO is saved in a file whose name 
includes the callsign of the station worked, the name of the contest, the 
date, time and band.  
 
When you first start QSOrder, if prompted by the Windows Firewall 
software, make sure you allow local network communication. QSOrder 
should tell you which audio input was selected. If it's not the right one, go 
to windows audio settings and change the "Default Recording Device" to 
the correct one (VAC1). Make QSOs in N1MM. The contest audio files are 
saved to the <contest>-<year> subdirectory as noted above. 
 
Pressing CTRL+ALT+O will save the current audio buffer to a file in your 
AUDIO_YYYY directory.  The hotkey should be recognized even when 
QSOrder window is not in focus. Use this key whenever you hear something 
interesting outside of a contest QSO (even when N1MM is not running). 
Whatever the MB1 is hearing, QSOrder will record 45 seconds of audio. 
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ReplayGain indicates the perceived loudness of the recording as reported 
by lame. This info is also embedded to mp3 files. 
 
 

 
 
 
Above shows an overlay of 3 windows. At the top, the Windows File Explorer 
showing an MP3 recording just made of IU4DTV. Below is the QSOrder 
window showing the creation of the initial .wav file which started when 
IU4DTV was logged in N1MM+ (bottom window). 
 
I later used the CTRL+ALT+O hotkey to record non-contest audio that was 
saved to the AUDIO_2016 sub-directory (not shown). 
 
To stop QSOrder, either close the command window or Ctrl-Break (the 
window may not react to a Ctrl-C right away - this is normal). 
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Transmitting 
 
N1MM+ help files show how to configure SSB macros. Essentially cq.wav, 
mycall.wav etc. files that you create yourself go in the N1MM 
Logger+\Wav\{your_call} sub directory and are called by the F keys or 
mouse clicks in the main N1MM+ window. We have already set up the audio 
path (refer above) so these wav files will be transmitted by the MB1.
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----------------------------------------------------------- 
 

 
If

There  Install. 2017. June 4 from 1.70K version updated an now is 
 http://hamsoft.ca/pages/mmtty.php from version latest the

 download installed, it have yet not do you and MMTTY use to want you 

 
The

 
Now
 
MMTTY:

 
MMVARI

 
MMVARI

 manual. N1MM the in explained fully is modes these of Operation
 PSK. example for RTTY, besides modes other in operate can 

  mode. DIGU in be
 should radio the so RTTY for DIGU of convention the follow does 

 transmit. into radio the put will TX and waterfall the on signals
 see now will You Window. Setup Digital the on also and here settings
 Save 2. Line is # Soundcard Output the that below and 1 Line normal

 our is # Soundcard Input the side, left the On Setup. Sounscard and Setup
 MMVARI to Go Window. Setup Digital the open will which Setup select

 screen, Interface the on 
 
MMVARI: Still MMVARI. select Interface, Under 

 waterfall). the of (left window Engine MMTTY
 the of panel front the on Rev set ESDR2, in DIGU For mode. DIGL in be

 to needs MB1 the so RTTY for DIGU of convention the follow does 

  transmit. into radio
 the put will 

 
MMTTY

TX waterfall. the on signals see will you and that OK 10. COM
 is Port FSK & PTT Tab, TX the On Sound. is Port Tx the Tab, Misc the On

 Transmission. for 2 Line and and Reception for 1 Line lines, VAC normal our
 pick Tab, Soundcard the On Option>Setup. to Go window. Engine/Waterfall

 RTTY the up bring will which MMTTY select Interface, Under 

  Interface. Window>Digital N1MM to go 

 screen. that exit and
 OK AFSK. also is mode MMVARI The AFSK. to mode MMTTY set and system

 your on mmtty.exe to path the Set Soundcard. select 1, Interface Digital
 For Tab. Modes Digital the select screen Configurer then O Other. Audio,

 Control, Mode Ports, Config>Configure N1MM to go is do to thing first 

 described. are both so engine MMVARI or engine
 MMTTY either use can  VSPE. in pair 10 9<>COM COM the created

 have you ensure 
1MM+N

Also working. CAT have youensure  ,digital up setting 
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                          K9DUR   VOICE-KEYER 
 
A

  job. the does DVK K9DUR the because situation this for windows
 of plethora its with N1MM+ use to necessary not is It  audio. normal yourthan 

 ‘punch more has it often pile-up, a in calling when voice your save it does only
 Not  pile-ups in calling for too.and contests for useful very is voice-keyer 

 
Click

 files.
 wav message the store and create to how describes file help K9DUR The MB1.
 the driving over avoid to adjusted be should and macro transmitted the of gain
 audio the controls VAC, 2 Line under volume The above. as parameters the Set
 window. configuration the open to screen main the from Hardware Setup 

----------------------------------------------------------   
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LATENCY  
  

Latency

 help. will CPU I7 a to upgrade the where is This 85. above is %
 utilisation its and load under is CPU the if worse is latency only: MB1 

 
For

   latency. lowest
 the achieving in point starting a as assist will they but characteristics
 microphone/voice your for optimal be not may They Module. Proc TX

 the for settings my for Addendum of section final the See 0.2ms. to Attack
 the reduce it, use you if or, off AGC MIC have either Module: Processor 

 
TX

    500. to figure Taps Filter TX the reduce Options>Device>TX 
 
In

    following: the try but cure complete a guarantee cannot 
 
I

   5. Beta 1.2.0 version from improvement an effected EE
 and latency the reduce to software their refined now have Anan and Flex

 SDR. plagued has SSB, in especially circuit, Monitor the in delay or 

 

------------------------------------------------------------- 

 
ENHANCED SKIMMER and DX CLUSTER 

INTEGRATION WITH ESDR2 PANADAPTOR 
 
As seen above, basic integration of CW Skimmer is possible with the 
ExpertSDR2 software. This affords local server output of CW spots to the 
MB1 spectrum display. The output is only of what your MB1 hears in CW 
mode. 
 
Yuri, UT4LW, has developed software that provides another level of 
integration. His SDC (Software Defined Connectors) program, formally 
UtilES, will take local Skimmer and / or DX Cluster Spots from an external 
server and output them to the MB1 display. All modes are supported so you 
can have spots displayed when in the SSB and RTTY sections of the band. 
Additionally, because the external server has filtering available, it is 
possible to reduce the number of spots on the spectrum display to only 
those that you wish to see. 
 
SDC also works in conjunction with 5MContest software. 5MContest is 
similar in many respects to N1MM+ but has some very interesting and 
useful features not found in N1MM. Both SDC and 5MContest are explained 
below. 
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SDC v8 and  Enhanced Skimmer / Cluster Display 
 
Download and install SDC version 8.63, using the link on page 1.   
After

 zip. the in
 one the with file ProTree.exe the replace file, install 8.63 the running 

 
Note
internal

  48-55. pages on described
 is 9 SDC Skimmer Afreet the support fully not does but .Server Skimmer 

 own its has 9 SDC .Skimmer CW Afreet the integrates fully 8.63 that 

 
 

Run the program SDC and in the system tray right click on its icon and 
choose ‘Show/Hide SDC Window’ The program window will open. Go to the 
Telnet Server Tab. 
 
Ensure your callsign is shown. Place check marks in the boxes as shown in 
the pictures below. Note the port numbers used in the Spotter A section 
(this is your local CW Skimmer) and in ‘Port For ESDR2 SKM Radio 1’. Also, 
note and apply the check marks where they appear throughout the form. 
The Spotter B section is for the external server with filtering capabilities (of 
which more later). I chose the DL9GTB Cluster/Skimmer server but there 
are others. An online search will identify them. Spotter C is another 
(optional) DX Cluster, similarly filtered to DL9GTB. 
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Close the SDC window by right clicking its icon in the system tray and click  Quit 
 

 
Refer to the CW Skimmer setup. 
In the CW Skimmer telnet tab, 
the port is 7300.   
 
In ExpertSDR Options, CW 
Skimmer tab, change the port to 
7310. This will connect ESDR2 
to SDC which, in turn, connects 
to Skimmer. 
 
Run ExpertSDR2 software, SDC 
and CW Skimmer. Open SDC 
and press ‘Start Spotters’. Press 
SKM in ESDR2. The MB1 will 
connect to both your local 
Skimmer and to the external 
Skimmer/Cluster that you 
defined in the Spotter B section 
of SDC. Both sets of Spots will 
print to your MB1 panadaptor. 
As the display fills, zoom out so 
that there is minimal overlap of 
callsigns.  
 
Use the SDC icon in the system 
tray to minimise it if you don’t 
want it open. It will run silently 
and unseen in the background. 
 
 
Automatic Start of Skimmer(s) 
 
If SDC is connected to a log 
(specifically the log telnet 
server), the Skimmer(s) will 
start automatically. Refer to the 
procedure described in N1MM+. 
In this case, the telnet server is 
connected to Port 7373. When 

the log connects to that Port, the Skimmer(s) start and their combined 
output(s) will go to the telnet server window in the log. 
 
An example is shown above from Swisslog which is connected to SDC on 
Port 7373. The local Skimmer spots are prefixed by ‘EI4KF-#’ and other data 
comes from SDC’s connections to DX Clusters or external Skimmers. 
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Using RX2 and 2nd Skimmer 
 
If you want to use both receivers in EDSR2 with a CW Skimmer running on 
each one, in SDC add another Spotter.  
 
The Skimmer is set up just like as described in the section above 
‘Connecting two Skimmers to ESDR2’. In ESDR2 Options > CW Skimmer, in 
RX2 the Port is 7311. As before, it is VAC 6 that is used. Set the Sample Rate 
to 96000. 
 
In SDC, at the top enable Port for ESDR2 SKM Radio 2 and define the Port 
as 7311. In the Spotter section, the Host Port is 7301. SKM Control is SKM 
Radio 2. Enable CWSkimmer Auto Start. In the Argument box define the 
path to the ini file for the 2nd Skimmer (as described in the ‘Connecting two 
Skimmers’ section. 
Note that in SDC, the format starts ini= and an example is like this: 
ini=C:/users/MB1/AppData/Roaming/Afreet/Products/CwSkimmer/rx2.ini 
 

If RX2 is running, when the SDC Spotters start, a CW Skimmer will run on 
that receiver as well as the main receiver. 
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Filtering 
 
Considerable filtering is now possible so that the Spots seen on the MB1 
display are only those that you want. A limitation at this time (April 2017) 
is that Expert Electronics have yet to include filtering of the local Skimmer 
server output. This will hopefully change in time. Nevertheless, filtering can 
be done to a great degree: 
 

1 Apply a filter command to the external server 
2 Manually turn off Spots from the local server 

 
1 Whether you use DL9GTB as your external server or not, his web page 
has a comprehensive list of filtering commands available. An example is 
what I use here. I do not want to see Spots of European stations and I do 
want to see Spots from European spotters only, and not from spotters in 
other continents. Skimmers are numerous so I also want to stop duplicates. 
The filter command for all of that is: 
set dx filter (cont=AS or cont=OC or cont=AF or cont=NA or cont=SA) and 
spottercont=EU and not skimdupe 
 

In SDC, type your filter command in the ‘send’ box for Spotter B and hit 
‘enter’ to send it to the server. The server will respond to confirm 
acceptance or else notify you of failure if you made a syntax error. 
 
2 As stated, the local Skimmer cannot yet be filtered and therefore it 
will output to the MB1 all that it hears (on CW). Should you not wish that 
at any time, manually turn it off with the radio button on CW Skimmer (but 
keep the program running). On SSB, RTTY and PSK, the local Skimmer will 
not output Spots anyway so it is only in CW that you might wish to turn it 
off and leave only the external server feeding the MB1 panadaptor. From 
SDC v6.5 it is possible to keep the local Skimmer on and have its output go 
to a Band Map window. See below in the section summarising the new SDC 
features. 
 
The external server, if DL9GTB or similar, also outputs Spots in SSB, RTTY 
and PSK. Therefore, these will be seen on the MB1 display when in those 
sections of the bands. 
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Image above shows 3 SSB Spots on the MB1 spectrum display. Note that 
they are all DX outside of EU, as a result of filtering. 
 
 
More you can do with SDC 
 
SDC is not limited to one Skimmer and one external server. Using the 
technique described on page 13, a second Skimmer can be setup for use on 
the MB1 RX2.  
 
After stopping Spotters in SDC, use the ‘+’ button to the left to create extra 
telnet clients. A new one could be used for Skimmer #2 and, in this case, 
assign port 7311 to it in SDC (‘Port for ESDR2 SKM Radio 2’) and 
ExpertSDR2. Yet more Spotters can be created: Spotter A, B, C, D, etc. These 
can be directed to additional external DX Clusters, Skimmers or the Reverse 
Beacon Network. All their DX Spots will go to the MB1 spectrum display and 
be filtered if the external server allows it and you apply such a filter. 
 
 
 

Summary of New Features and a Basic Description of SDC v8 
 
From version 6.5, an English language help file is included. To access it, go 
to the Setup Tab and select English Help file. Then click on the book icon at 
the top right. 
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The help file explains most everything but the program does many different 
things and is quite complex. So, a basic description and function of each 
component follows. 
 
Profile Manager: The idea is to be able to quickly modify an ESDR2 profile. 
When you save your settings in ESDR2 and give it a name, it is saved as 
name.prfl in c:\users\MB1\ExpertSDR2\profiles. If you open this file in 
SDC Profile Manager, you will see all the primary sections and sub-sections 
that cover all the settings of the MB1. From this, changes can be made and 
saved to a new profile, retaining the original intact. It can be combined with 
another profile, perhaps one with additional VACs for SO2V operation, and 
saved for use during contests. 
 
COM Spider: This creates all kinds of connections to both physical and 
virtual com ports. For systems where 3rd party software and/or external 
devices are running on the MB1 computer, Spider has limited use because 
VSPE already does everything. However, some MB1 users have a separate 
computer also in use. This may be to facilitate various contest setups or to 
share the CPU load when using more than one Skimmer. Here COM Spider 
allows the networking of com ports, audio and CW key. The possibilities are 
extraordinary and a thorough reading of the Help file is recommended. 
 
Note: Also see below the section on Com-0-Com virtual port software and 
its optional usage with COM Spider. 
 
RigSync: The SDC program implements a synchronization system between 

transceivers (or receivers) for VFO frequency, modulation type, split, and 

other parameters. Two independent synchronization channels, each of 

which may be associated with the corresponding device, can also be 

connected to OmniRig, or the ExpertSDR2 server (see ESDR2 Options). 

Telnet Server: Is explained above in the enhanced Skimmer / Cluster 

display section and in the 5M Contest section below. SDC version 6.5 

introduces a new feature, Band Mapping. This is useful because it can allow 

local Skimmer spots to be directed to the Band Map instead of, or as well 

as, to the ESDR2 Panorama. Directing only to the Band Map reduces on-

screen clutter in the Panorama. You will recall that external Skimmer 

servers can have filtering on their output so that only DX, e.g. non-Europe, 

Spots go to the Panorama. But the local Skimmer cannot be filtered so all 

its Spots, regardless of location, go to the Panorama which causes it to fill 

very quickly. Now, in SDC from v6.5 place a check mark in the section ‘Port 

For ESDR2 SKM for BandMap’ and remove the check mark from ‘to Pan’ in 

the local Skimmer Spotter pane. The result will be that non-EU DX Spots 

will go to the Panorama and local Spots of all that the MB1 hears will go to 

the BandMap: 
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Above: Spots on Panorama from external Skimmers (non-Europe only) and 

everything on the BandMap. Therefore, the BandMap shows the complete 

band activity and the Panorama is not cluttered. This is very useful in 

contests. In SSB of course, the local Skimmer does not receive anything and 

the external Skimmers alone fill the Panorama so the BandMap is more 

useful in CW mode. As you tune the band, the cursor will move along the 

Band Map and each entry will be highlighted with the Spot source and dB 

reading. 

Window <<Acti-Spot>> is designed for continuous monitoring of activity 

from a user defined station. It could be a DXpedition or your own callsign if 

you want to know when you’ve been spotted in the Cluster. Activate with 

the Show ActiSpot option in the Telnet Server Tab and enter into the box 

the call for search. 
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Audio Client and Audio/Com Server: are for where Skimmer, for example, 

is on another computer. Additionally, the Com server allows both audio 

channels and com port data to cross to the second computer via a LAN 

(Ethernet). 

 

SDC Version 8: Integral Skimmer Server  

In version 8, an alternative to CW Skimmer has been implemented. SDC 

now has its own Skimmer(s). Therefore, it is no longer necessary to have 

the Afreet CW Skimmer software to run Skimmers on the EDSR2 receivers. 

Advantages of SDC Skimmers: 

a) Free of charge, not necessary to buy CW Skimmer at $75 

b) CW Skimmer takes up CPU resources and running Skimmers on 2 

receivers can push the computer CPU load to 100%. The SDC 

Skimmers take up less resources. 

Disadvantages of SDC Skimmers: 

a)  CW decoding traces do not have callsign tags and hence are not 

easily identifiable except by their output to the SDC band-

map.  later). (see 9 SDC in implemented is This 

b) The decoding ability of the SDC Skimmer is nearly as good as CW 

Skimmer but is slightly less capable. However, there are numerous 

configurable settings for it in SDC and some experimentation may 

make it match CW Skimmer. 

Overall, having an alternative to CW Skimmer is a tremendous bonus and, 

since it has only just been introduced, may very well be enhanced as Yuri 

develops SDC further.  9. SDC in available are improvements Several 

 

SKM Server Setup: 

The configuration of the CW Skimmer section in ESDR2 Options is 

unchanged.  

In SDC, select the SKM Server Tab and press the ‘+’ sign to define Skimmer 

A. In the Skimmer A Setup Tab, define the VAC to match ESDR2 and enable 

TCP Server. So, for example, if in ESDR2 Options, CW Skimmer Tab, you 

have VAC 5 defined then set this in SDC with the Driver as WDM-KS.  
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In SDC, the configuration of the Telnet Server is just the same. 

 

 

Now, note these changes to the Spotter configuration. In Spotter A replace 

the Port number 7300 with ‘-1’. If you are defining two Skimmers, in Spotter 

B replace the Port number 7301 with ‘-2’. Uncheck CWSkimmer Auto Start. 
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Ensure that the SDC Telnet Server is started and is connected to ESDR2 (a 

blue connected plug symbol is displayed instead of the red unconnected 

plug). 

 

On the SKM Server Tab, press Start Servers 

 

 

 

Then on the Telnet Tab, press Start Spotters 

 

Press
 band-map. SDC the to output

 its with start, will Skimmer internal the and Tab Server SKM on Start 
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The starting of the Spotters and Skimmers is all automated by connecting a 

log to Port 7373. When the log connects, the Spotter(s) and Skimmer(s) 

start. 

Set these in the SDC Setup Tab: 

 

 

44



 

 

 

Information available with each Skimmer: 

By clicking on a trace in the Skimmer display, another window opens. 

Below is seen a new window below the Skimmer. This shows the CW 

decode, the callsign of the station and other technical information. 
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SKM Server Configuration 

 

 

Various settings on the SKM Server > Global Setup Tab are used to optimise 

decoding ability and call verification.  
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A Firstly, set the path to the MASTER.DTA file.  

B The ‘Verify Call’ section sets the number of times a callsign is decoded 

before it is ‘verified’ and sent to the logger and band-map. In the above 

example, if the signal strong and found in DTA the call needs to be decode 

only once. Weak but found in DTA, decoded twice. If not found in DTA, set 

the number of times the call has to be decoded, perhaps 3. If CW Skimmer 

had such a verification routine, we would not see the numerous false Spots 

that Skimmers send to Clusters or RBN. 

C ‘Call Regular Expression’ governs how much if the decoded callsign is 

sent to the ESDR2 Panorama. In its default setting, 3 suffix characters are 

sent. So, a callsign such as OL75SILVER will be displayed as OL75SIL. This 

is to prevent over-lapping. Change the expression in this setting to suit your 

preference. 

D The ‘Without CQ’ parameter defines how often the callsign has to 

heard to be sent to the band-map and logger. A station that sends CQ is sent 

anyway. Therefore, define how many times a call is heard without CQ to be 

sent.  

E Other settings on the SKM Server Tab affect the SNR and band width 

of the detection algorithm. 

 

On the SKM Server>Skimmers Tab, above the Skimmer display is a setting 

called With Abbreviation Test Only. Normally left blank, but in a specific 

contest any characters entered here will affect the callsigns being decoded. 

For example, enter LZ for the LZ Contest to decode only LZ stations.  

 

 

Hybrid Combination Afreet Skimmer and SDC Skimmer 

Senario: you own Afreet CW Skimmer and want to use RX2 with a 2nd 

instance of Skimmer running on it. Computer resources are maxed out with 

two receivers and two Skimmers. A possible solution is to run the Afreet CW 

Skimmer on RX1 with all its advantages. On RX2, run the SDC Skimmer 

Server with its output to the SDC band-map and log. Let this run in the 

background.  

 

Simply setup the Afreet Skimmer in SDC on Port 7300 as before. On another 

Spotter, set up Skimmer Server with the Port as ‘-2’. 
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You now have a hybrid system running both type of Skimmer. On the MB1, 

with two external monitors that run ESDR2 at a very high CPU rate and push 

the computer to the limit, this can allow you to have two Skimmers. 

Previously having two Afreet CW Skimmers running would cause those 

Skimmers and ESDR2 to run erratically.  

 

Profiles 

All aspects of SDC can be saved to Profiles. This includes SKM Global setup, 

Skimmer server setup and Telnet Server setup. This allows total flexibility. 

For example, you could have a Profile for when only RX1 is used and another 

for when both RX1 and RX2 are being used. 

 

SDC Version 9: Integral Skimmer Server to ESDR2 via TCI 

Yuri has now updated SDC to version 9. Unfortunately, he has decided to 

dispense with Afreet CW Skimmer integration and only his own Skimmer is

If  fully

 

supported.  you have the Afreet Skimmer, it is possible 

 

  interfere. not will so TCI via separately but run still will Skimmer

 SDC The port. telnet Afreet the match to accordingly Tab Skimmer

 CW ESDR2 configuring and Tab Telnet the on it to connecting by 9 SDC

 with it run to 

 If you do not have the , Skimmer Afreet or want to use the SDC Skimmer, 

then SDC 9  v9.17) (currently can be obtained from 
https://www.dropbox.com/s/nji20fdkkf7p6q5/SDC_9_setup.zip?dl=0  

The

 

A

 

 above.

 information 8.63 the of duplicate a is it of Some follows. Server

 Skimmer the to relevant extract, part A software. the with installed

 is program, the of features the all for manual, user SDC full 

  completeness. for given is but section 8.63 the of repeat a

 is follows what of Much protocol. Interface) Control (Transceiver TCI new

 the utilising ESDR2 with integration 9 SDCdescribe  pages following 
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SDC

TCI

Expert Electronics developed and implemented a new protocol in ExpertSDR2 software 
for managing and receiving data from the transceiver. It allows you to realize the 
transmission and reception of data over one connection, which will greatly simplify the 
configuration of external software and increase the reliability of the comple ityx  as a whole.

The connection via the TCI protocol is described in the "TCI" tab.
To add / remove a TCI client, use the +/- buttons. If you plan to work with two or more 

transceivers (receivers), create an appropriate number of TCI clients.
Specify the name of the connection (it will be used later in other sections of the SDC), 

address and port.
!! The "Connect" button should only be used to check the connection to the transceiver. 

Leaving it pressed is not necessar .
 

y

 

SKM Server

The SDC program has a built-in skimmer-server for connecting and working with transceivers and receivers
running under ExpertSDR2. Connection and management of skimmers occurs in an automatic mode,
synchronous with the operation of receivers

 below. as changes, few a are there
 - 8.63 to identical almost is 9 SDC in Server the of setup The.
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SDC

Section «Setup». Verify Call. Here you configure the validation of the call sign:
Strong signal and Call in DTA – For powerful signals and callsigns, which are included in the Master.DTA

directory. If set to 1, then it is enough to decode this one once to send a spot.
Weak signal and Call in DTA – For weak signals and callsigns, which are included in the Master.DTA directory.
Call not in DTA – For stations that are not included in the Master.DTA directory.
 

 

For example, if the last item is set to 3, then only after a three-time decoding of the callsign of the Master.DTA
not listed in the directory will a spot be generated.

Without CQ (0-newer) – Indicates the number of repeated decodings to send a spot to stations that do not
indicate the abbreviation CQ, TEST, WSEM in the call

 
.

Master.DTA File Location: Indicates the location and name of the file with callsigns.
Call Regular Expression – A regular expression for searching for callsigns in the decoded text. By default,

expression: ([0-9][A-Z][0-9][A-Z]{1,3})|([A-Z]{1,2}[0-9]{1,4}[A-Z]{1,3})

Detect receiver Setup. Installations of the detector of a telegraph signal.
Signal/Noise detect (dB) – The excess of the signal level above the noise level is indicated, to determine it as a

CW station.
Band Width detect – Bandwidth of the receiver-CW signal determiner.

Decoder receiver Setup. Decoder settings.
Spot Frequency Round – Round-off of the spot frequency. 50 - with an accuracy of 50 Hz, 100 - up to 100 Hz.

Band Plan – Frequency plan for ranges. The table shows the frequency intervals in which the CW stations will be
decoded and the spots generated.
It is possible to create a set of frequency plans and save them to profiles

 
 

 
 

.
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SDC

 

Skimmers

Control Panel:

[Start SKM Server] – To manually start all skimmers. When working with Telnet Server, you do not need to click this
button; This will happen automatically.
[+] [-] –Add, remove skimmer.
Profile: Select, delete, overwrite, create a profile.
With Abbreviation Test Only – You can specify the abbreviation of the test, for selecting the stations that give the
appropriate call. For example, specifying "MM" - you will receive spots only for those stations, which in the call add
the letters MM: CQ MM. You can specify several options through a comma
 

.

 Skimmer Setup
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SDC

In External Window -  When the skimmer is started, its window will be displayed separately from the main window of
the SDC - for fans to observe the movement of CW signals.
Control Type – Selection of the method for controlling and transmitting the IQ stream.

TCI Only – Control and transmission of the IQ flow will be carried out via the TCI interface.

Audio + TCI – The control will be performed via the TCI interface, and the IQ stream will be transmitted via

  

the VAC  device/ audio cable.

The first method is more stable, does not require any audio cables and their settings, but each skimmer will
further load the CPU by 5-10 percent.

The second method will reduce the load on the CPU, but will depend on the 
 flow

 stream IQ entire the and cables,VAC

 

setting.

TCI Client – The TCI client is specified, which is described in the TCI tab of the SDC program.

Receiver – Indicates the number of the receiver to which this skimmer is connected.

If the Audio + TCI control type is selected, the type of the sound driver and the sound device through which the IQ flow 
will be delivered are indicated
 

.

Spotter Name - specifies the name of the spot, which will be used when generating spots
 

.

TCP Server - each skimmer can be declared a server, to which third-party programs for receiving spots will be
connected. Specifies the port
 

.

Log - to monitor the spot issuance protocol

 
 
 
 
 

 
 
 
 
 
 

 
.
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SDC

 

Telnet server

This utility is used to combine the spots coming from different sources into one stream with its own server,
which in turn is used to connect the logs to it. Consider, for example, the creation of a server for combining spots
with two skimmers and RBN.

In the example above, the scheme of the "Telnet Server" utility will have the following scheme:

For processing, the spots of the RBN cluster and two of their skimmers (A, B) will be used.

 

Telnet Server

This is the server to which logs will be directly connected.
[Start] - the server start button. The button should be constantly pressed.
Port: - port number of the server.
Log - to view the log exchange protocol.null
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SDC

 

Spots -> Panorama
The section is designed to control the process of spotting the panorama of the ExpertSDR2 program in

conjunction with the work of the 5MContest log-log, or any other log that can control the operation of the skimmer.

New, Mult, Dupe – Indicate which callsigns will be displayed on the panorama. To the right of them are buttons,
which you can set the color to which these callsigns will be displayed. If the repeats (Dupe) are not marked, then
these callsigns will automatically disappear from the panorama after communication with the ..m

 
 

 

Add Windows

ActiSpot – A window in which the S potting of your callsign shown is (or 
 callsign) DXpedition

 a e.g choosing your of callsign 
 

 

Acti Spot

On the left, three thermometers are displayed, which inform the user about the activity of the spotter. Their
number corresponds to the number of spotters. In this case, the RBN cluster and two of its skimmers. The latter is
highlighted in red, indicating that there is no connection to the spotter, or it is not active.

On the right is an empty field where your station's spots will be displayed, for example:

 
With "Band Map 1" and "Band Map 2" you can quickly control the display of the corresponding Band Map.
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SDC

 

Band Map

BandMap for RX1, RX2 – Bandmaps that display the state of the band near the tuning frequency.

If the transceiver is operating in SO2V mode, Band Map2 displays VFOB frequency data. In SO2R mode, Band
Map 2 displays data for the second receiver.

You can click on the Band Band, or on a specific callsign
 

.

 

Spot Manager Settings

Profile: - Profile, which will be loaded when connecting the log, which does not correspond to the statuses of
callsigns.

  – Delete the selected profile.

 - Overwrite the selected profile.

 - Enter the name of the profile and save it.
Use a special profile when 5MContest connected – A profile is specified, which will be loaded when connecting to
the 5MContest contest.

 [Start Spotters] – Manual start of all spotters, which are marked with jackdaws. The button is "pressed"
automatically when the log is connected to "Telnet Server".

[ +] – Add a spotter window to the right.
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Additional  continued Parameters Skimmer 
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 as 1 COM on PA (our CAT on operating device the to protocol TCI the translates
 then and TCI via ESDR2 to RigSync attaches This above. as 2 and 1 Control Rig 

 Tab. RigSync the to go Now choice. your of is name device 

 below. as Spider COM set COM1, is port
 physical MB1 the that Remembering ESDR2. to connected is Client TCI the 

 RigSync. and Spider COM for Start Auto set Also Tab. Setup
 the on them enable so Tabs RigSync and Spider 

 
My

 
In COM the to access need we 9 SDC 

 simple. very is It device. any for same the
 be will procedure the but amplifier 1.3k-fa SPE the on again based is example 

 etc). winkeyer, digimode, (loggers, software for only setup be only need ports
 virtual and used is 9 SDC case this In -0-COM!COM nor VSPE for need the without

 controller, antenna dynamic or ATU auto as such device controlled CAT external
 other or amplifier, controlled CAT a with MB1 the interfacing allows ESDR2 in 
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5MContest and Enhanced Integration with ESDR2 
 
 
There is a web site for 5MContest software at http://5mcontest.qrz.ru/  
 
A video showing the software being used in a contest and its integration 
with ESDR2 is at https://www.youtube.com/watch?v=nLBNLZFEr2I 

 

Note how working a contest station whose Spot is on the panadaptor makes 
that Spot disappear, leaving only needed contacts on display! 
 
Download and install the latest full setup exe file from the 5MContest web 
site.  
 
On the web site, there is also a link to an English language help file for 
5MContest. I therefore will not go into detail about all the features of the 
program. The following description is how to setup 5M so that it integrates 
with ExpertSDR2 as in the video. I will then cover some basics of 
5MContest. 
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In
 TELNET_SRV.EXE to TELNETSRV.EXE

 file the rename 5MContest, installed you where folder the 

 
Start 5MContest, go to Management>5MContest Settings>Radio-OmniRig 
Tab. If you haven’t installed or configured OmniRig, do so now as this is 
required. 
 
Set the CW Skimmer Telnet server address and port as you see above. Check 
AutoStart and set the path to SDC (ProTree.exe). Whilst on this Tab, for the 
purposes of rig control, also check PTT via CAT. 
 
on

 .below picture See Skimmer. CW start automatically
 to program the include program, Common>External Tab the 

 

Press

 display. spectrum the from Spot the remove will program the logged, and worked
 is 7X3WPL, example below the in station, the When   window. QSO New the in

 ready be will callsign the and QSY will MB1 the and Spot the Click map. band the on
 Spot their put and Skimmer local the on mode) S&P in answering those to opposed
 (as mode run in CQ calling stations contest identify will program The open. window

 Map Band the and window QSO New the least at have 5MContest In  preference.
 your per minimised or open it have Either open. will SDC operation. contest non- for

 ‘DXpedition’ pick Or year. whole the for calendar contest the see to contest’ another
 ‘Assign under Look contest. the of selection the for box a present and Skimmer CW

 launch automatically will It 5MContest. Run  SDC. Quit automatically. Profile correct
 the select and running is 5M whether detect will SDC 5M. with use for another

 and situation contest non- a in SDC for one is there that so Profiles define now can
 you SDC, In Profiles. to reference the and above See form. the close and Apply 
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Note that only DX Spots that are on the panadapter via Skimmer spots can 
be removed automatically.  
 
As you tune the band, working the stations, so you will clear the MB1 
spectrum display of your Skimmer spots thus making it very easy to see 
what it still needed. 
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5MContest Setup 
 
The program has a downloadable help file in English which is invoked by 
pressing Help in the main program window. The setup is quite 
straightforward. Obviously SSB is simple enough and will record QSOs as 
they are made. Data modes are catered for by MMTTY or MMVARI. CW is 
slightly different to N1MM+ in that there is no support for Winkeyer. 
However, this does not matter as the program will send CW macros via a 
COM port. 
 
To setup CW, refer to page 5  about how to create a single virtual COM port. 
In our example, this new one will be COM 11. In 5MContest, select 
Management and CW/PTT Settings. 
 

 
 

 
At the top, for Radio 1, enter COM11 and check CW. PTT can be checked but 
is probably not necessary. Go to ESDR2 Options>Device>CW Tab and, for 
RX1, select COM11 for the Port name and RTS for PTT / DTR for Key line. 
Check Enable Secondary Key and Apply and Close. CW macros when sent 
will key the MB1. 
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COM-0-COM 
 

COM-0-COM is an alternative to VSPE for creating virtual com ports. Some 
people prefer it but it is not as flexible as VSPE since it does not allow port 
splitting and serial redirection. However, if all you want to do is interface a 
logger to ESDR2, then it is simple and also completely free of charge with 
no registration nag box as there is in VSPE.  
 
Should you prefer COM-0-COM to VSPE and you want to interface more than 
one software and/or a CAT controlled device like an amplifier, then COM-0-
COM can still be used but in conjunction with COM Spider in SDC. 
 
Download COM-0-COM from  
https://sourceforge.net/projects/com0com/ 
 
After installation, you will be presented with the setup screen: 
 

 
 
Only com port pairs can be created. The above example shows two such 
pairs. For simple connection of a logger to EDSR2, only one pair is required 
for RX1 as was seen in the VSPE section. It is useful to check the two boxes 
for ‘emulate baud rate’. So, the RX1 CAT in ESDR2 would be set to COM 3 
and the logger to COM 4. RX2 would use COM 5 and 6. 
 
The more complex configurations achievable with VSPE can be made with 
COM-0-COM with the help of the Software Defined Connectors application. 
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COM-0-COM with SDC for more complex interfacing 
 
Even for only RX1, is necessary to create two com port pairs in COM-0-COM. 
In SDC, we will utilise the COM Spider feature. One pair will link EDSR2 with 
COM Spider and the other pair will link COM Spider with the logger. This will 
also allow amplifier interfacing with the MB1 CAT. 
 
After creating the two pairs, go to the COM Spider tab in SDC: 
 
 

 
 
 
 
Create a new Profile and save it. Port A connects to EDSR2 so with COM 3 
defined in EDSR2 CAT for RX1, the Port here will be COM 4. The port type is 
Real COM and then add check marks to the boxes for where the CAT data is 
to be sent. 
 
Port B is for the logger. One side of the COM 5-6 pair is for COM Spider and 
the other is for the logger. So, the Port B port is 5 and then set COM port 6 
in the logger. Check the box to send data to EDSR2. 
 
To add CAT out from EDSR2 to an amplifier, define Port C. The amp CAT is 
physically connected to the MB1 through the rear panel COM socket. This is 
fixed as COM 1. Therefore, The Port C port is COM 1. Ensure to check the 
box to send data to EDSR2. CAT data will flow from EDSR2 to logger and 
the CAT enabled amplifer. 
 
Once this is all set, save the Profile on the Com Spider tab and set up any 
automatic launch of COM-0-COM at boot up if you prefer. 
 
 

--------------------------------------------- 

64



 
 

TROUBLESHOOTING TIPS 
 
This is by no means an exhaustive list. The most common questions that I 
have been asked about have been collected together below. 
 

1 No audio from MB1 – ensure that ‘sound out from SDR’ is set either 
in the MB1 Utility or from ESDR2. Also, if speaker audio is required, 
ensure ‘Speaker’ is enabled. If PC audio is required, set ‘Sound out 
from PC’. The MB1 volume must be greater than -60dB as that is the 
point at which the audio is muted. There is also a Mute button so 
ensure this is not activated. 

 

2 No SSB transmit audio – ensure you have the correct type of 
microphone for the MB1 mic input. Mic 1 is for electret microphones 
and so the usual Heil mic will not be compatible. Mic 2 is for dynamic 
mics. Select the Mic input in software to match the input you are 
using. Mic gain is likely to vary between microphones but, for 
example, my Mod Mic is best at 10dB of gain with a compression 
setting of 4.4 and a threshold of -27dB. 

 

3 Output power is significantly less than 100 watts – output varies 
anyway with more than 100W on some bands and less than 100W 
on others. If output is very low, ensure you are reading Peak and not 
RMS. Turn off Mic AGC for full output (but check for over-driving). 
The bar-graph meter in the computer GUI is useless on TX so, if using 
this GUI, invoke the additional pseudo S-meter which shows mic 
gain and coloured segments for AGC control. Do not get confused 
between Drive and Tone, the latter is only for setting up external 
devices and the main MB1 power out is controlled by Drive. 

 

4 Excessive background noise on receive – optimum dynamic range is 
served by having the wide RX filter set to off. DITH should be 
unchecked in Options>Expert Tab. 

 

5 Settings to optimise weak signal DX working on CW: the common 
question is the meaning of and the best setting for Filter Taps. 
Experiment yourself but my settings are 1000 for CW (and SSB). 
Filter Taps represent the filter shape. The higher numbers mean a 
more rectangular shape but at the expense of delay.  

 

 
----------------------------------------------- 
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MB1 CONTROLS NOT COVERED IN MAIN MANUAL 
 

A revised MB1 user manual, version 1.0.1, was published 26 Feb 2017. If 
you missed its publication, it is on the MB1 download page. It is better 
organised, more accurate and has an improved layout over the original. The 
following may or may not be included in it but are listed for convenience: 
 
1 Front panel TxB button sets on/off SubRX and Split simultaneously. 
 
2 Control the tone output power by the TUNE DRIVE slider in the tuner 
menu, power level is displayed on the T.PWR indicator. When the tone mode 
is activated, Drive knob on the front panel controls T.PWR. 
 
3 RX ANT functionality: in the antenna switch menu there is an ‘RX 
ONLY’ button for each HF antenna input, so now you can lock several 
antenna inputs for RX simultaneously. 
 
4 Now with LOCK enabled you can tune RIT offset, but the XIT is still 
locked. 
 
5 Indicators in the MB1 style functions as buttons. 
 
6 Fast enable for VHF LNA – long press of the ATT button; 
 
7 Stack memory for the antenna switch: while controlling the HF 
antenna input from F1-F2 buttons (RX A1 – RX A4), set the required input 
by the first press, set the previous input by the second press. 
 
7 VOX level control via knob on the front panel (with enabled SHIFT). 
COMP level control via knob on the front panel (with enabled SHIFT). 
NB1/NB2 level control via knob on the front panel (with enabled SHIFT). 
 
Note: To control VOX trigger threshold you need to enable SHIFT, then 
secondary functions will be assigned to the knobs.  You adjust VOX 
threshold for active Mic (if you choose MIC1 then VOX threshold will be 
adjusted by the MIC1 knob). 
 
Note: SHIFT is enabled by pressing and holding the WF/SHIFT button. 
 
8 ATU settings memorised according to the tuned frequency. 

ATU operating frequency is from 1.8 MHz up to 30 MHz. 
 

9 Added full functionality for the keyboard (secondary functions of the 
” 0-9, “.”, ENT ” buttons). 
 

-------------------------------------------- 
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UPGRADING THE MB1 
 

As supplied, the MB1 has 8GB RAM and an Intel i5 6400T CPU. Running 
external monitors, CW Skimmer, etc causes the MB1 computer to be slow – 
the 8GB RAM supplied is sufficient for basic operation but not if you add 2 
monitors and run Skimmer. This will max out the CPU usage at 100%, 
making the CPU over-worked and will generate a lot of heat. A dramatic 
improvement is gained by adding another 8GB RAM to bring the total to 
16GB. RAM is cheap. The correct module is a Kingston KVR16LS11/8 (not 
the 16S11 which has the wrong voltage).  
 
RAM 
 
Adding RAM is extremely easy and requires no special knowledge or 
procedure. Access is by removing the case screws and lifting the MB1 top 
case. Remove the screen. There is a speaker attached to the underside of 
the screen and so be sure to carefully detach the speaker leads.  
 
The spare RAM slot is easily apparent. Merely add the new 8GB module. It 
is fitted at an angle and then pushed flat.  
 
CPU 
 
High-end users may still find, even with 16GB RAM, that the i5-6400T CPU 
is still over stretched. This is likely with the 2 receivers running in addition 
to the 2 monitors, 2 Skimmers, and other software.  
 
The CPU upgrade is to a i7 6700T. This is the only CPU model that can be 
used. The T model is a 35W device and is necessary because the MB1 case 
is not strictly a computer case and cannot exhaust the heat generated by 
the normal 65W devices. 
 
Note also that although the CPU replacement is another easy task, per 
Gigabytes recommendations, there are some necessary procedures to 
follow. Therefore, ensure that the details below are carefully considered. 
 
Access is as before. Ensure that the MB1 is unplugged from the electricity 
supply and is stood on either a rubber or anti-static mat. 
 
The CPU fan is removed by unscrewing the spring-loaded screws. Turn anti-
clockwise until you hear a click. Carefully pull up the fan and move it to one 
side. 
 
Press down on the CPU lever, move it slightly right, then raise it up. The 
CPU can be removed. The replacement CPU can be inserted. Obviously, its 
orientation is the same as the old CPU but it has an arrow lower left side to 
match the socket. Slowly close the lever and secure it under the hook. 
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Now the important procedure: cooling is a critical issue and heat 
transference from the CPU, through the fan and exhausted from the MB1 
case is of paramount importance. A volume cooling test was conducted on 
the MB1 by Gigabyte and you should take these steps: 
 
A The underside of the fan will be contaminated with old grease and 
must be cleaned thoroughly. Acquire a thermal material remover such as 
‘ArctiClean 1’ to dissolve the grease. Follow this with a thermal surface 
purifier such as ‘ArctiClean 2’. Use lint free cloths for the job.  You should 
restore the fan heatsink to pristine condition: 
 
 

 
 
 

 
B The recommended thermal paste to use is ‘Arctic Silver 5’. It is less 
likely to decay over time than other pastes. Do not spread it over the surface 
of the CPU as this creates minute air pockets. Instead apply a vertical line 
in the middle of the CPU. To see an example go to 
http://www.pcadvisor.co.uk/how-to/desktop-pc/how-to-apply-thermal-paste-cpu-
3636146/ Re-fit the fan. Tighten the screws evenly and in turn. As the fan 
squeezes against the CPU, the paste will evenly spread without its integrity 
being compromised. 
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The results: With original CPU and 
MB1 running 2 external screens, 1 
receiver, 1 CW Skimmer, logbook 
and SDC > CPU at or near 100%.  
 
The receiver can also experience 
issues when the CPU is near 100% 
such as ‘scratchy’ artefacts if 
software such as a web browser is 
opened. Sometimes the panorama 
is not smoothly rendered. 
 

 
 
 
 
 
 
 
With i7 6700T CPU, the CPU usage 
is down to 68%. Even with 2 
receivers and 2 CW Skimmers, the 
usage does not exceed 85%. The 
performance of both the computer 
and SDR show a tremendous 
improvement. 
 
 
The 6700T is available all over 
Europe from ‘Alternate’ at about 
320 euro. It also is often seen used 
on eBay. I bought mine on eBay for 
250 euro, used but ‘as new’.  
 
 

 --------------------------------------------------------- 

Document produced by Erik Carling, EI4KF, September 2017.  Errors, questions relating to the 
descriptions herein, &
 

 erikcarling@live.com to omissions 
 

ExpertSDR2 software is owned by Expert Electronics. Direct support requests to info@sunsdr.com 
 
Software Defined Connectors and SDC Skimmer are the property of Yuri UT4LW. Direct support 
requests to  ur4ix@mail.ru 

3.1 
 
Version  
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TX PROCESSING MODULE 

 

 - turns on the compression of the transmitted signal.   

Via the drop-down menu, you can adjust the compression and 

threshold level.  

  

Mic Gain and Compression settings:  

1. Set the Meter to the Mic-meter mode (right click on the S-Meter->TX-> Mic-meter).  

2. Set the Drive level to 0.  

3. Enable the TX mode and speak in the microphone.  

4. Increase the Mic gain from 0 dB till the Mic meter readings will reach -10...-5 dB in peaks.  

5. If required enable the compressor.  

6. Set Compression to 2-5; set COMP threshold to ~ -30 dB. This level should be more than 

room noises for about 10-15 dB.  

 - enable the microphone signal processing menu (PROC). Profile adjustment in this 

menu is similar to the global profile menu:  

 add a new profile, by entering the name of the profile in the “Profile name” field and 

pressing Add button.  

 Update the settings of the certain profile from the list to the current settings.  

 Remove the certain profile from the list.  

Note! All new profiles will be stacked up to the drop-down menu as a new line.  

It consists of the following functions:  

DC block's purpose is to effectively remove Time constant in the 

microphone signal. Changing of Time constant influence quality of 

the applied filter. You can test it by increasing or decreasing Time 

constant value in 1-10 ms range, you’ll notice low frequencies 

reduction with 1 ms value and amplifying with 10 ms value.   
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Parametric filter module with graphic display of the summed AFC (amplitude-frequency 

characteristic – white line) and AFC of each filter. Simultaneously you can use up to 5 filters. 

Available filter types:  

Lowpass – Low Pass Filter (LPF). This filter passes signals with a frequency lower than a 

certain cutoff frequency. Cutoff frequency is determined by Frequency. Quality determines 

steepness of the filter slope.  

Highpass – High Pass Filter (HPF). This filter passes signals with a frequency higher than a 

certain cutoff frequency. Cutoff frequency is determined by Frequency. Quality determines 

steepness of the filter slope.  

Bandpass – this filter passes frequencies within a certain range (band) and rejects 

frequencies outside that range. Cutoff frequency is determined by Frequency. Quality 

determines bandwidth of the passband.  

Notch – it is a band-stop filter with a narrow stopband. It rejects a specific range of 

frequencies and passes all the other frequencies unaltered. Tuning frequency is determined 

by Frequency. Quality determines the stopband bandwidth.  

Peak – also known as bell filter. This filter has similar functionality with the Notch filter, but 

has more flexible settings. It boosts or cuts the chosen frequency by Gain value, affecting 

the surrounding frequencies in a bell-shaped curve. Tuning frequency is determined by 

Frequency. Quality determines the cutoff bandwidth.  

Low Shelf – this filter cuts or boosts signals of frequencies below the cutoff frequency, 

determined by Frequency. Gain value determines attenuation or boost level of frequencies 

below the cutoff frequency. Frequencies above filter’s AFC will not be altered.  

High Shelf - this filter cuts or boosts signals of frequencies above the cutoff frequency, 

determined by Frequency. Gain value determines attenuation or boost level of frequencies 

above the cutoff frequency. Frequencies below filter’s AFC will not be altered.  

Noise gate or gate, removes signals below 

Threshold level. Usually it is used to 

reduce the noise in pauses.  

Gate passes signal only when it’s level is 

higher than set Threshold: gate is open. If 

the signal is lower than set Threshold, gate 

will not pass it (or significantly attenuate): 

gate is closed. Gate should be used when 

the level of the desired signal is higher than  

the noise level. Gate’s level is set higher than the noise, so when there is no desired signal 

(higher than Threshold) gate is closed. Gate does not cleanse the signal from noises. When 

the gate is open, both signals get through, useful signal and noise.  

Parameters:  
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Ratio – attenuation value, when Gate is closed. Usually this parameter is set for full rejection, 

i.e. signal does not pass through Gate, when it’s closed. But sometimes you might require a 

mild rejection in this case adjust Ratio.  

Threshold – it sets the level for Gate to open – pass the useful signal. It supposed to be set 

above the noise level, but below the useful signal level.  

Attack – it sets time (ms), required for Gate to change state from closed to fully opened. If 

Attack time is short, as soon as the signal level goes higher than Threshold, it creates a 

sharp noise, longer Attack time creates a smooth transition from closed to opened state, but 

because of it, you may miss first sharp characters, like T, K.  

Release - it sets time (ms), required for Gate to change state from opened to fully closed. If 

Release time is short, as soon as the signal level goes lower than Threshold, it creates a 

sharp noise, longer Release time creates a smooth transition from opened to closed state, 

it may sound like fading.  

  

Compressor – is used to reduce dynamic 

range of the audio signal, in other words, 

compressor reduces the difference 

between the quietest and the loudest 

sounds.  

Compressor automatically controls the 

volume.  Downward compression reduces 

loud sounds over a certain Threshold while 

quiet sounds remain unaffected.  

Compression may improve sound audibility in loud places, where background noises may 

suppress quiet sounds. While loud sounds will be easily audible, quiet sounds won’t be 

audible, and if you’ll increase overall volume, it will improve the situation for quiet sounds, 

but loud sounds will become unbearable. If you’ll apply the downward compression to this 

audio, the overall volume may be increased to the level when both quiet and loud sounds 

will be comfortable to listen.  

Parameters:  

Ratio – determines the ratio of input/output signals which exceed Threshold. For example, 

ratio of 3:1 means that if input level is 3 dB over the threshold, the output signal level is 1 dB 

over the threshold.  

Threshold – a compressor reduces the level of an audio signal if its amplitude exceeds a 

certain threshold. It is set in decibels dB.  

Compressor may be adjusted in a way how fast it reacts:  

Attack – this is the period, when the compressor is decreasing volume to reach the level that 

is determined by Ratio. It is activated when the signal exceeds Threshold and, if each 

consecutive signal has higher volume than the signal before it.  
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Release - this is the period, when the compressor stops compression, increasing signal 

volume to the default level. It is activated right after Attack period is finished. Each time, 

when after the compressed signal goes the next one, which is lower than Threshold or 

higher, but lower than the compressed one before it, then instead of Attack, Release is 

applied for each consecutive signal like this one and compressor stops compression 

according to Release settings. Whether there will be a compression or not while Release 

period, depends on the set time. If in Release period signal is compressed, it is compressed 

with the same Ratio (dB) as the signal before it. Only in that case sounds lower than 

Threshold may be compressed.  

Attack and Release parameters should be adjusted depending on how frequently signal 

volume is changing.  

Type Soft/Hard knee - controls whether the bend in the response curve between below 

Threshold and above Threshold is abrupt (hard) or gradual (soft). A soft knee slowly 

increases the compression as the level increases and eventually reaches the compression 

Ratio set by the user. A soft knee reduces the audible change from uncompressed to 

compressed, especially for higher Ratios where a hard knee changeover would be more 

noticeable.  

 

Limiter – is used to limit dynamic 

range, when signal exceeds Maximum 

Amplitude value. In most cases used 

to avoid overload(clipping) and 

suppression of short term level peaks, 

while signal dynamic range is being 

levelled. As a rule, limiter is used 

along with increasing the input level 

on the Input Boost value, this 

technique increases overall signal level, while preventing distortion. 

Parameters:  

Attack - this is the period, when the limiter is decreasing volume to reach the level that is 

determined by Max Amplitude.  

Release - this is the period, required for the signal level to be restored to the default value.  

Hang time – sets time (in ms) to keep the signal level the same, after Attack period is over, 

before beginning Release period.  

Input Boost – preamplifying of the input signal before limiter processing.  

Maximum Amplitude - sets the signals maximum amplitude on the limiter output.  
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Parametric equalizer module with graphic display of the summed AFC (white line) and AFC 

of each equalizer. Each equalizer has independent set of controls: the center or primary 

frequency (FREQ), bandwidth (BW) and AFC level (boost or cut) – vertical slider. Press right 

mouse button on any control element to set it to the default value. Thus, using the parametric 

equalizer you can perform the finest tuning on any required frequency.  

In this module, you can find 3 types of filters: Low Shelf (on the left), High Shelf (on the right), 

Peaking or Bell (8 units in between). Their operation is similar to the filters described in the 

Filters module.  

  

AGC module is responsible 

for keeping the constant 

volume level of the Mic 

signal. Max AGC value 

might be adjusted by the 

Mic gain on the software 

front panel  -  

. If the Mic signal on the AGC input is too weak, then you might  

need to increase the Mic gain. AGC has a delay period which is adjusted by the Attack, 

increasing the Attack value will increase delay period.   

Parameters:  

Attack – signal attenuation period, this value determines how fast AGC will decrease the 

amplitude of the loud signal to the Maximum Amplitude value.  

Release – signal recovery period, this value determines how fast AGC will increse the 

amplitude of the loud signal to the value which does not exceeds Maximum Amplitude.  

Hang time – sets time (in ms) to keep the signal level the same, after Attack period is over, 

before beginning Release period.  

Maximum Amplitude – sets the signals maximum amplitude on the AGC output.  
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Clipping is a form of waveform distortion that occurs when the output Voltage exceeds 

Threshold. Visually (on oscilloscope) it looks like altered signal peaks, you can hear it as 

splutters and cracks. Clipper reduces signals peak-factor and increases overall power, but 

distorts the signal.  

Parameters:  

Threshold – if the signal exceeds this level, Clipper alters it, sets in dB.  

Type Soft/Hard knee – controls whether the bend in the response curve below Threshold is 

abrupt (hard) or gradual (soft). A soft knee slowly changes the curve towards the clipped 

signal. A hard knee would be more noticeable.  

  

 

In the Profile tab, you can save settings of the whole TX processing module in a separate 

module, independent from the main software profile. Save your settings in a file by pressing 

the Import button and load profiles by pressing the Export button.  

To add new profile, enter unique name in the input box and press the Enter button on your 

keyboard. You may also delete selected profile, by pressing the - .  

 

Additional notes from Vasily (translated from Russian) 

 

1. Noise Gate works strictly on the threshold level. Which threshold was set, so it will cut the 

signal. Now imagine Noise Gate with a threshold of -30dB, which means that weak sounds 

in the voice below 30dB relative to the signal peaks will be cut off and replaced by silence. It 

is logical that the voice characteristics will be slightly cropped from below and there will be 

an effect of "clothes pegs on the nose." Try to play around with the threshold. I put the value 
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under -50 ...- 60 dB and signal is excellent. Yes, the noise in the office is small. If there is a 

fan, it is necessary to raise this threshold. 

2. Clipper - at a low threshold level, and in general when clipping a signal with a clipper, a 

signal with exponentially damped spurs above 0 dB at the beginning of each cropped 

fragment is obtained at the output. This is an overload of the modulator. The fact that the 

clipper stands after the AGC creates the possibility of overloading the modulator. You need 

to enter into the clipper parameter Max amplitude, as it is done in the AGC microphone. 

Adjusting the clipper as needed, you can lower the microphone level on the AGC output by 

the same Max amplitude parameter on the AGC tab (by default it's 0dB), controlling the 

microphone level on the MIC meter indicator (right click on the S-meter, TX, Mic-meter). The 

microphone level should be slightly below 0dB for loud sounds. 

3. It is necessary to monitor the overall dynamic range of the resulting frequency response of 

the equalizer - the white line. Because the frequency response of all bands is summed, then 

adding the signal level on the three adjacent bands, the final signal will be higher. As a result, 

you can adjust the equalizer so that the difference between the bottom and maximum level 

will be 30-50 dB, which too much compared to the dynamic range of the entire signal (it will 

sound distorted). To adjust, it is necessary to turn off all the effects, evaluate the unevenness 

of the frequency response of its signal on the panorama in TX mode and compensate with 

an equalizer (equalized the AFC and added to if necessary). In my opinion more than 20-25 

dB difference in the frequency response of the equalizer does not need to be done. 

 

 

Additional notes from Erik EI4KF  

Below is a description of my TX Proc settings with some explanation for them. Each user will 

have a different microphone (mine is an Antlion Audio ModMic 4 on the Mic1 input), different 

voice characteristics and want a preferable end product such as full-range or DX punch, etc. 

So, the following is not prescriptive but should be a starting point. My own target preference 

is for DX working with minimal latency so that I can use the Monitor. 

DC Block is useful as makes a subtle difference to the amplification of low frequencies. I 

have enabled with a time constant of 5ms. 

Filters suitable for my voice and for DXing are only High Shelf. The others do not help in my 

case. I have Frequency 2000Hz, Quality 0.7 and Gain 6.0dB. 

Noise Gate is off because I find that it ‘muddies’ the signal. There may be an optimum 

combination for its parameters but I doubt its overall value. 

Compressor makes such an improvement to the MB1 output that it is almost mandatory to 

have it enabled. Ratio is 4.0:1, Threshold -30dB, Attack 10ms, Release 10ms, Type Hard. 

Latency in the Monitor circuit is slightly worsened if Attack and Release times are extended. 

76



  

 

   
 Expert Electronics   

2017   

Limiter is enabled with default values except that Input boost is set to +2dB.  

Equaliser is enabled – its settings will depend on preferences and voice characteristics. All 

my gains are at zero except 4dB and 3dB for the 2.00K and 4.00K ranges respectively. 

AGC is the same as Mic AGC. I cannot achieve anywhere near maximum output power with 

it enabled. Neither can I properly drive my external PA in SSB with it enabled. However, for 

JT65 and FT8 AFSK modes, it is enabled to ensure proper AGC control of the transmission. 

In this case, I have decreased the Attack to 0.2ms. 

Clipper is enabled with Type set to Hard and Threshold at -8dB. This is for increased audio 

punch. 

 

------------------------------------------------------------------------------------------------------------------------ 
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